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Design & Visual  
Communication II
The following provides a record of the daily studio process.  
A typical studio meeting includes review of work in progress, 
introduction of new concepts, skill building, sketching and computer 
instruction.

Class 1: Monday

Welcome/Roll
Introduce Myself, Hope you had a good Christmas.  Take Roll

132 Syllabus
Texts:  132 Syllabus & Color Drawing—page 13.
Note addition of color media—page 16. 
You must have colored pencils by next class.
Hand out any updates.

Project 5:  Drawing
Overview of Weekly Drawing project.
Have by next class:  
Strathmore, 300 Series, Newsprint, Rough, 18 x 24 (use old pad). 
Cachet, Classic, 9" x 12" sketchbook (purchase new book).
Due Wednesday: 
Review Drawing project statement in the 132 Syllabus

Class Participation
Class participation is an important area that I would like to see improve in the 
coming quarter.  To this end I would like each of you to record on a sheet of typ-
ing paper your thoughts on the following question.
What would support your verbal participation in class discussions?
Make personal notes 
Time:  About 5 minutes
Divide into small groups and introduce yourselves.  Share your personal notes.
Record three to five things that the group feels are most important for supporting 
individual verbal participation. 
Time:  15 minutes
Gather and record group’s lists on large sheets on the wall.  Groups identify one 
item at a time until all are recorded.
What observations can be drawn from the list? 
Discuss key factors and how they can be overcome.
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Break:  15 min.

Class Overview
Use examples on the wall to give an overview of the quarter’s work.

Color Explorations:  Phase I
Introduce Phase I of the project.
Give brief introduction to color theory. 
Traditional color wheel:  Subtractive/Pigment. 
RGB color:  Additive/Light 
CMY color:  Subtractive/Printing 
Gerritsen:  RGB+CMY 
Hue, Value & Chroma
Read Phase I of the project statement for next class—pages 27-33. 
Bring required colored pencils & Sketchbook to the next class.

A Folly:  Phase I
Overview of the project—use work on the wall 
Discuss value of group process. 
Discuss grading Group & Individual.
Hand out and complete the Personality & Skills form. 
Time:  8 min.
Introduce Phase I of the project.
Divide into small groups. 
Share your Personality & Skills responses. 
Brainstorm recommendations for cutting planar and lineal elements. 
Show materials and reinforce key construction techniques on page 52.
Due Wednesday: 
Read A Folly Phase I—pages 49-52. 
Cut out some of each of the lineal and planar elements and bring to class.
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Personality & Skills
  
 Name: ___________________________

 131 Teacher  _____________________     Grade  _____

Personality

 Favorite Color:_______________________
Each pair of opposing terms defines a continuum.  Place a big dot on each line to 
indicate were you think you fall along each continuum.  If you are not sure what 
a term means, discuss it with a neighbor or ask the teacher.

 Art ...................................................... Technology

 Abstract ...................................................... Pragmatic

 Theory ...................................................... Practice

 Visual ...................................................... Verbal

 Introverted..................................................... Extroverted

 On Time ...................................................... Late

Skills
Place a big dot on each line to indicate what you think is your level of skill rel-
ative to each category where 0 is low and 5 is high.  The placement of the dots 
should also indicate your relative strengths between categories.  Drawing focuses 
on freehand drawing where drafting focuses on instrument aided drawing.  Mod-
els refers to physical models.  Digital refers to drawing with the software pack-
ages we have been using.

 Drawing 0.................................................... 5

 Drafting 0.................................................... 5

 Models 0.................................................... 5

 Digital 0.................................................... 5
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Class 2:  WEDNESDAY

Warm-up
Creating letters using markers and colored pencils. 
Show Lin page 77-78?? as examples. 
Use your name to practice. 
Work in your sketchbook.
Time:  20 min.

Marker Name Card
Read activity statement in syllabus, page 17 
Name Cards with marker & colored pencil letters. 
Show past examples & examples for Lin. 
Hand out 5 x 7 cards. 
First name large, Last name small. 
Three goals you want to achieve this quarter on the back or front.
Card Due Friday.

Color Exploration:  Phase I
Are there any questions from reading the project statement for Phase I?
Work on Phase I with colored pencils. 
Time:  1 Hour.
Due Friday 
Completed color wheel.

Break:  15 min.

Folly:  Phase I
Small groups to look at pieces and offer suggestions. 
Discuss any issues that come up.
Due Monday:  Phase I:  Lineal & Planal parts.
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Color of Many Colors:  A Colorist Approach
The colorist attitude toward creating colors is that they are always the result of 
mixing many colors.  In the following exercises you are to use only those colored 
pencils that are used to create a traditional (Red, Yellow, Blue) color wheel.
Trace the grid provided in light red prismacolor lines. 
Trace the lettering in black pen.

Tint:  A Hue mixed with White.
The colorist approach always starts with a tint—hue plus the white paper show-
ing through—assuming that you are working on white paper.  This is required 
because there needs to be uncolored paper left to receive subsequent hues in the 
mixing process.  
Principle:  Use transparent layers of color.

Gradation
Start with a single dark hue and create a gradation from opaque/solid to the light-
est tint possible.  Build the gradation from the darkest end by layering and gradu-
ally extending toward the lightest end.  Change pressure to help build the grada-
tion.

Black
Create Black from a Black pencil and from many dark hues (no Black pencil).  
Note the difference in the richness of the two blacks.  Create dark values by lay-
ering multiple colors—avoid using lots of back to create dark values.

Chroma & Value
Create four squares of a hue (Orange)—they should be similar tints.  Choose a 
medium Gray, Black and complementary hue (Blue).  Layer Gray on the second, 
Black on the third and the complement on the fourth.  In each case, the value 
will become darker and the chroma will be decreased.  Note that using the com-
plement creates the richest color.  
Principle:  Use complements to darken and reduce the chroma of hues.

Analogous Hues
Choose three analogous hues (Red, Orange, Yellow) and layer them to create a 
color.  All layers should be created with a light pressure.  Note the richness that 
this creates.  Repeat with two other analogous sets.  The first and last hues used 
will tend to control the color perceived as dominant.
Principle:  Create all colors from many colors.
Give a slight gadation to the area with a complimentary hue.

Experiments
Try different hue combinations. 
Look at darker on lighter and lighter on darker combinations. 
Try the same hue combinations in different orders. 
What guidelines for using colored pencils can you draw from the experiments.
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Tints

Single Hue Gradations

All Hues Blacks

Tint

Analogous

Experiments

Tone Shade Compliment

Black

Multi Hue Gradation
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CLASS 3:  FRIDAY

Name Card
Small groups to share goals. 
How would someone recognize that you have achieved your goals? 
Show under camera.  Make observations. Collect.

Color Explorations:  Phase I
Gather in small groups.  Bring completed color wheel. 
Compare color wheels and make sure everyone understands.
Hang color wheels on the wall. 
Discuss quality and any questions?
Time to work on other Phase I parts.  Try each to make sure that you understand 
task.  Allot 45 min. including the break.  Ready to start at 9:30. 
Questions?
Due Monday: 
Phase I:  Final:  Original drawings.

Break:  15 min.

Weekly Drawings:  Color of Many Colors
The first weekly drawing is to explore the mixing of colors to create colors.   
Show examples of weekly drawings.
Colorist Principles
Principle:  Use transparent layers of color.
Principle:  Create all colors from many colors.
Principle:  Use complements to darken and reduce the chroma of hues.
Exercise
In your sketchbook do a colorist free form doodle.   
Use my free form sketch as an example. 
It should have a full value range, use many hues and develop a sense of form 
based on an assumed light source. 
Time:  20 min.
Due Wednesday: 
Drawing #1:  Color Of Many Colors
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Break:  15 min.

A Folly:  Phase I
In your sketchbook, note three things that you can do in a group that will make 
the group experience more productive and enjoyable
Divide the class into groups.
Share what you wrote.
Brainstorm and record: 
What other things can you do individually and as a group that will make the 
group experience more productive and enjoyable?
As a group, identify the three most important things from the list.
Come together and have each group contribute an idea until all are recorded.
Due Monday: 
Read Appendix to Folly project, pages 63-71 
Highlight and note questions.

A Folly:  Phase I
Due Monday: 
Phase I: Kit of Parts:  Points, Lines, Planes and Base. 
Do not do Plant Materials and Figure.

Big Friday
Timed drawings from projected images. 
Do three versions of an image.  Wacachachi
1:  4 min, Continuous line, Media:  Marker.
2:  4 min, Surface & Volume with value, Media:  Art Stix.
3:  8 min, Open, Media:  Marker & Art Stix.
Hang images on the wall and make comments.

Computers
Bring computers Monday.
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CLASS 4:  MONDAY

A Folly:  Phase I
Put your kit of parts out for me to evaluate during class. 
Organize the pieces and place your name card with the parts.

Weekly Drawings:  Color of Many Colors
Review Drawing 1: Color of Many Colors. 
Review requirements for the backing sheets. 
Review requirements for compositional alternatives. 
Reinforce compositional goals. 
Questions?
Colored Pencil Techniques
Develop the value structure of the whole drawing with successive passes. 
Work Dark to Light:  Develop darkest values before lightest.  Judge light against 
dark.  You can add much easier that you can subtract.  (Lin page 37) 
Work Rough to Smooth:  Put first value down quickly and refine as desired.
Shade adjacent areas and patch seam:  When shading a large area, break it down 
into comfortable reigons that do not overlap and then patch the seams.
Creating precise straight edges:  Shade against a transparent straight edge.  Tape 
the edges of the drawing (reduce tack of the tape).
Repairing:  Tape to lift color.  Kneeded erase to lift color.  Knife to scrape off 
color.  Tape on erasing shield or creating magic square.
Score paper to create white lines.
Due Wednesday:  Drawing 1

Color Explorations:  Phase I
Hang Phase I drawings on the wall. 
Record in your sketchbook three things you learn from this phase?
Share what you learned. 
Discuss any observations.
Collect Phase I:  Orginals and Grade Sheet.
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Break:  15 min.

A Folly:  Phase II
Assign teams:  Gather with team. 
What ideas generated Friday did the reading reinforce? 
The ideas did the reading add?
Identify a spokes person for the team.  Gather and share.
Things to Say: 
Emphasize Team Rules. 
Roles:  Each team must decide how to address. 
Peer Evaluation and Self-Evaluations will be filled out by everyone after the proj-
ect is complete. 
Grading emphasizes individual work.  Only the craft and design of the model will 
be shared by the team.
Due Wednesday:  Read Problem Statement & Phase II (pages 53-57)

Break:  15 min.

Complexity Continua
Each person is to diagram a three step complexity continuum on a sheet of typing 
paper.   
Time:  5 min.
Hang continua on the wall. 
In your sketchbook note one that is particularly clear and why. 
Share your observations with a neighbor. 
Share key qualities that contribute to making a clear complexity continuum.
Which ones seem clear?  Why? 
Share your observations and discuss.
Reading:  "Complexity" in Means To Ends, Pages 45-51

Color Explorations:  Phase II
Review problem & show color wheel.
Due Wednesday: 
Read Phase II project statement & Build the color wheel.
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Freehand Tutorial:  Class 4

Constructing Color Wheel, Specifying Colors, Applying Colors.
Set grid to .5”. 
Turn on all Snaps. 
Set guidelines to 4.5" in from left and 6" up for the bottom. 
Drag the 0,0 ruler point to coincide with guidelines.
Rename the default Foreground layer “Primary” and make it active.
Draw 2” and 6’ diameter circles centered on 0,0. 
Hold the Shift and Option/Alt keys while drawing the circles. 
Set line weight of 1pt and fill of none. 
Select and Join (Command + J) the two circles.
Draw a vertical line from 0,0 to a point clearly beyond the 6” circle. 
Choose the line and open the Transform palette (Double click on the Rotate tool). 
Enter Rotation Angle 7.5°, Center 0,0, Copies 6 and click Apply.
With the Transform palette open, select the vertical line and enter  
Rotation Angle -30°, Center 0,0, Copies 1 and click Apply. 
Select and send all radiating lines to the Guides layer.
Choose Line tool and draw lines that define either side of the section of the color 
wheel to be created. 
Place the first point at 0,0, turn off Grid Snap and click on the appropriate radi-
ating guide line beyond the circle.
Open the Extra Operations palette and locate the Divide tool if it is not visible. 
Select the joined circles and the two lines. 
Click on the Divide tool. 
Delete the unwanted portion of the joined circles.
Select the section of the color wheel just created. 
Double click on the Rotate tool. 
Enter Rotation Angle 60°, Center 0,0, Copies 5 and click Apply.
Save the file and lock the layer.
Repeat the process for the Secondary and Tertiary colors using appropriate di-
ameter circles (2", 3", 4", 6") and degrees of rotation (60°, 60°, 30°).  Once the 
color wheel is created the layers can be unlocked.
Create CMYK colors as specified in problem statement. 
Add colors to the Color List. 
Name and organize the colors in the Color List as specified in the problem state-
ment.
Apply colors:  Hold down shift key to insure they are applied as fills.
Select all and set lines to white and 2 point.
Make a circle that is larger than the color wheel for the color names. 
Cut the circle at each primary line. 
Type Primary color names. 
Set alignment to center. 
Bind text to paths. 
Change direction of paths when necessary.
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CLASS 5:  WEDNESDAY

Weekly Drawings:  Color of Many Colors
Small groups to present your drawings. 
What quality/feeling were you trying to communicate? 
What would strengthen communication?
Hang drawings on the wall. 
Best exploration of color of colors. 
Best sense of form and light. 
Make comments. 
Questions?
Collect Drawings

Color Explorations:  Phase I
Return Phase I Evaluations.
Have color wheels with you at all times as a reference.

Folly:  Phase II
Having read about complexity, create another three step complexity continum. 
They must be abstract — no recognizable/nameable elements. 
Time 8 min.
Hang continuua on the wall. 
What are the factors that contribute to complexity. 
Make observations on and discuss examples.
Discuss Number, Variety and Relationship. 
Present the complexity continum from the reading and its implications. 
Respond to questions.

Break:  15 min.
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Folly:  Phase II
We are going to create a series of spaces.   
How would you communicate a continuum of spaces. 
Create a complexity continuum of spaces? 
Time 8 min.
Hang the drawings on the wall. 
How can space be represented? 
Make observations.
Review the requirements for Plant materials and Scale Figures.
Show examples of diagramming problem statement. 
Work together to Diagram the Problem Constraints & Requirements in your 
sketchbooks. 
Record any questions that you want answered or issues that you want discussed.
Due next Class:  Every team mamber: 
Create a complexity continuua diagram in your sketchbook. 
Problem Statement diagramming in sketchbook. 
1 Tree, 1 Hedge, 1 Person.

Break:  15 min.

Color Explorations:  Phase II
Discuss layout design. 
Page layout and element sizes (what is longest name, biggest drawing) 
Need to generate titling/format ideas that accommodate variation. 
Respond to questions.
Review problem statement concerning slices.
Due Friday:  Color Wheel, One Slice & One Chart.  
Proposed page layout with each.  Print pages.



14B E N E D I C T
Arch 122 Daily2008

Computer Tutorial:  Class 5

Page Format:  Master Pages
Creating a master page. 
Set units and grid.  Turn on rulers and snap to grid. 
Adding elements:  Guides to define element location & Shared elements. 
Go to Library palette to name master pages.
Add shared text.  Developing text styles.

Color Slices
Overall area equals 10 x 3p plus 9 x .5p = 34p6 square. 
Drag in guides to define a 3 pica square and 6pt gutter in each corner 
Create a 3 pica square in each corner set to some fill with no stroke. 
Blend the corners set to 8 steps to define the perimeter of the square.
Delete all but the Black, White and future primary hue squares.
Create the White to Black gradation and give the White square a line.
Duplicate the page twice to make the three slices.
Delete unnessary squares and specify the primary Hues for each slice.
Blend in the manner indicated in the diagrams—45° blends.

Color Charts
Overall area equals 11 x 3p plus 10 x .5p or 38p0 square. 
Drag in guides to define a 3 pica square and 6pt gutter in each corner 
Create a 3 pica square in each corner set to some fill with no stroke.
Duplicate the page for each chart.
Specify corners. 
Choose two squares (two corners first). 
Click on the Blend tool or choose Modify > Combine > Blend. 
Enter 9 in the Objects inspector and hit Return. 
Ungroup twice to break the blend apart. 
Blend down or across to define two sides of the chart. 
Blend across or down to fill in the chart.
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CLASS 6:  FRIDAY

Big Friday
Timed drawings from projected images. 
Media:  Art Stix. 
Do three images. 
Time:  8 minutes each.
Hang images on the wall.

Weekly Drawings:  Color of Many Colors
Show selected drawings and make comments. 
Return drawings.

Break:  15 min.

Color Exploration:  Phase II
Divide the class into groups. 
Present your color wheel, slice, chart & page layouts.
Hang prints on the wall and bring your sketchbooks. 
Which layouts would support variation in content? 
Discuss observations & Comments.
Record computer questions on paper provided. 
I will meet individual with students to answer computer questions during team 
work time.
Due Next Wednesday 
Phase II Final Submittal

Break:  15 min.
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A Folly:  Phase II
Gather with your team: 
Identify any questions concerning the problem statement. 
Gather and Respond to questions.
Discuss spatial definition issues: 
All circulation and spaces paved and on one level. 
Circulation versus space. 
Sequence of spaces and transitions. 
Straight path versus path that changes directions.
Gather with your team. 
Share and discuss the complecity diagrams that each member has produced. 
Play with the kit of parts to discover how elements can be created. 
Discuss the team's direction and goals for the complexity continuum.
Time about 90 minutes.
Due Next Class:  Each Member 
Complexity continuum diagram in sketchbook 
Model of a space

Cooperative Reflection
At the end of the class have each person do the following:
Look at Team Member Evaluation Form 
In your sketchbook:   
Two criteria that you think you have meet successfully. 
Two criteria that you can improve on. 
Time:  8 min.
You have control over your actions. 
Everyone in the group is making the best decisions they can. 
See that everyone is involved. 
Don’t just do what you do best. 
Teach each other so all gain from the experience.
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CLASS 7:  WEDNESDAY

Warm-up:  One-Point Perspective
Setup One-Point perspective depth experience. 
Use both room and scale model. 
Have students see how half way works.
Use the model, cone of vision and diagram to develop rational for width of scene 
setting the distance from PP to Station point.
Draw two 4" squares on a page in your sketchbook.
Left Square: HL at 2" with person—cube 10', create 10' cube using half way be-
tween HL & GL.
Right Square: HL at 2" with person—cube 10', create 10' cube using half way 
between HL & GL as 20'.
Compare the two cubes 
Give rational based on cone of sharp focus and visual quality of cube. 
Rule of thumb:  Half way is never less than 20.
Time 30 min.
Due Next Class:  Read Drawing Form, Pages 45 - 49.

Color Exploration:  Phase II
Layout your prints and circulate to view. 
Hang up your color wheel, one slice and one chart.
Reflection:  Three things you learned from this phase.
Collect prints and disks.
Due after break:   
Photocopy of reflections.

Break:  15 min.

A Folly:  Phase II
Gather with your team. 
Share your continuum concept diagrams.
Draw a team Contimuum Concept Diagram. 
Must represent the complexity continua.   
Must represent the path, site and the three spaces. 
Size, Shape, Implied/Explicit, Number, Variety & Relationship 
What will change and what will stay the same. 
Time 20 min,
Hand preliminary continuum concept diagrams on the wall. 
Which ones communicate complexity? 
Which ones communicate something about the path? 
Which ones communicate something about spaces? 
Discuss qualities that support different communications. 
Your diagrams should communicate all issues.
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A Folly:  Phase II
Gather in your Teams. 
Work to develop clarify your concept and develop your design.
Due Friday: 
Prelim. Continuum Concept Diagram and progress on the model.
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CLASS 8:  FRIDAY

Weekly Drawings:  Big Friday
Timed drawings from projected images. 
Media:  Art Stix. 
Do three images. 
Time:  8 minutes each.
Hang images on the wall.

Weekly Drawings:  Organic Things
Introduce drawing and show past work.
Due Wednesday: 
Drawing 2:  Organic Things

Break:  15 min.

A Folly:  Phase II
Work with your group.
You have from now until 11:15 to work with your team to desihn your folly.
11:15 Return to individual seats. 
Reread the peer evaluation form. 
Individual notes in your sketchbook. 
Refer to the evaluation form. 
2 things you are doing well and why. 
2 things you could improve and how. 
Make comments on individual responsibility.
Gather with your team.  Hand out paper. 
Discuss with your team members: 
How well everyone participated.   
Note 1 way participation could be improved. 
How well the team stayed on task.   
Note 1 way staying on task could be improved. 
How well the group made decisions.   
Note 1 way decision making could be improved. 
Comment on participation, focus and decision making. 
Collect papers.
Due Monday: 
Final Preliminary Model (not titling or diagram),  
Preliminary Concept daigram.
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CLASS 9:  MONDAY

Weekly Drawings:  Organic Thing
Review drawing assignment and look at past drawings. 
Note use of rectangle.
Due Wednesday:   
Drawing 2:  Organic Thing

Color Explorations:  Phase II
Hange examples on the wall. 
In sketchbook compare and contrast two projects to identify one thing that you 
can learn from them about creating better layouts. 
Share observations. 
Make comments. 
Return projects and grades.

Inspiring Architect
Remind students of need to pick an architect.

Break:  15 min.

A Folly:  Phase II
Each group is to place their model and diagram on a table in the room. 
Place models on a table and clear space arround it. 
Gather with your group and plan what is to be said. 
Choose who will do the presenting. 
Each group will have a maximum of two minutes. 
How are you creating the complexity continuum, 
What is held constant and what changes?
Circulate about room and each group makes presentation.
Put comment sheet with each model. 
Circulate as a team and write a suggestion under each category. 
Three minutes for each model. 
Finish at your model and review suggestions.

Break:  15 min.
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A Folly:  Phase II
Gather as class. 
Critique projects and make suggestions concerning figures, single spaces, posi-
tive negative, transitions, complexity continuum, etc. 
Make observations and comparisons of different models. 
Emphasize any issues that need reinforcement (e.g., positive/negative and ex-
plicit/implied). 
Respond to any questions.
Get out problem statements and review project constraints and design goals with 
your team.  Work in class to develop and improve your design and construct your 
final model
Do diagramming exercise. 
Paving then paving & walls, Then Paving, walls & Roofs. 
Show examples and discuss diagramming.
Due Wednesday: 
Progress on the model and diagram.

Group Process Reflection
Return to your desks. 
Hand out sheets of paper.  See next page. 
No names on the sheets.  Fill out the sheets.
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Constructive Criticism:  A Folly
Strongest assets that the continuum possesses.

Suggestions for improving the continuum.
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Group Process Reflection
Identify two strengths of the group process you just experienced.

Identify two shortcomings of the group process you just experienced.

Describe one thing that you would do to make the group experience more 
successful next time.
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CLASS 10:  WEDNESDAY

Warm-up:  One-Point Perspective
Create Ground Line.  Mark off subject width on GL. 
Draw section on PP:  30' wide by 20' high.  HL at five feet. 
Set 30’ depth using half way between HL and GL.
Create a 10' grid on all surfaces. 
Add a 3D form.  You are to add two or three additional forms and shade the 
drawing.
Collect and look at the drawings for problems.

Weekly Drawings:  Organic Things
Small groups to present drawing. 
Color of many colors?  Value structure supports form? 
Compositional use of the rectangle?
Hang drawings on the wall. 
Drawing that best communicates a unique subject. 
Make any appropriate comments.
Collect Drawings

Break:  15 min.

A Folly:  Phase II
Respond to written group evaluations.
Work in class on model and diagram.
Next Class: 
Final model and diagram 
Bring 11 x 17 Grid paper.  Bring Computers.



25B E N E D I C T
Arch 122 Daily2008

CLASS 11:  FRIDAY

Big Friday
Timed drawings from projected images. 
Media:  Art Stix &/or markers. 
Do three images. 
Time:  8 minutes each.
Hang images on the wall.

Weekly Drawings:  Organic Things
Make comments and hand back the drawings.
Introduce next drawing. 
Show examples of past work.
Due Wednesday:   
Drawing 3:  Joining Materials

A Folly: Phase II
Reflections: 
2 things you learned about design spaces. 
1 thing you learned about building models. 
1 thing you learned about how you work in groups.
Due Next Class:   
Photocopy of Reflections

Break:  15 min.

A Folly: Phase II
Lay models and diagrams on tables. 
Circulate and note changes and improvements 
Share observations.
Collect Models and Diagrams

Color Explorations:  Phase III, Found Compositions
Cut 1” and 1 1/2” squares in a sheet of typing paper. 
Draw two 3” squares on a sheet of typing paper. 
Trace the squares onto a second sheet. 
Choose a Kandinsky work.
Use holes to find compositions. 
Reproduce compositions in 3” squares. 
Show past examples.  You cannot expect to make a photographic copy of what 
you choose.  You must capture the essence — the most important qualities. 
Time limits. 
1 minute to search. 
4 minutes to draw.
Do three found compositions.
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Uncover the whole work and put your first drawings so that you can see them. 
You are to create the last composition by using elements and patterns found in the 
whole work. 
Time limits: 
1 minute to study work. 
4 minutes to draw.
Divide the class into small groups.  Bring your two pages of drawings. 
Identify some quality in your drawings that you can use to teach the class about 
creating better compositions.
Gather and hang all your drawings on the wall.  Have each group present their 
lesson.  Discuss.
Closing Points to make: 
Your compositions are very good.  They reflect your intuitive understanding of 
good design.  Trust your intuition. 
Quick sketches are a good way to generate design alternatives. 
Design inspiration can come from many places (e.g., a work of art).
How did it feel to do these drawings? 
Share observations.

Color Explorations:  Phase III
Introduce problem and show past examples. 
Questions?
Due Next Class: 
Read Phase III 
Minimum of six compositional ideas in your sketchbook. 
Developed composition in Freehand at 6” sq.  Bring print & File.

Computer Tutorial:  Class 11

Freehand:  Color Library
Choose Options > Export in Colors palette. 
Select the first color and Shift click the last to select all colors.  Click OK 
Name library: 6 Primaries.  Name File: 6 Primaries.???.  Click Save.
Import Color Library 
Choose Options > 6 Primaries 
Shift click to select multiple colors.  Click OK.  Organize colors in the palette. 
30 min. 

Freehand:  2D Composition
Techniques for creating the Composition in freehand.
Cut shapes with Knife set to close path. 
Cut shapes with a line and the Divide tool. 
Clone a shape or line if it is to be used more than one time to cut another shape. 
Clone and reshape the clone to match original on one side. 
Lineal shape:  vector line, change handle type, shape path, expand path. 
Pencil tool set to Calligraphy, Draw, Remove Overlap, Split.



27B E N E D I C T
Arch 122 Daily2008

CLASS 12:  MONDAY

Warm-up:  One-Point Perspective
Create Ground Line.  Mark off subject width on GL. 
Draw section on PP:  30' wide by 20' high.  HL at five feet. 
Set VP about 5' off center. 
Set 30’ depth using half way between HL and GL. 
What should the depth line represent: Double largest dimension rounded off 
Find 30 feet deep and Create a 10' grid on all surfaces. 
You are to add two or three forms and shade the drawing.
Perspective Quiz
One-point perspective exercise on the next page. 
Follow the instructions.  Think: 
I will collect the quiz in 20 min.
Collect Quiz
Review the basic construction process.

Break:  15 min.

Weekly Drawings:  Joining Materials
Reminder of drawing due. 
Refer to "Color Drawing" for ideas and techniques for representing materials.
Due Wednesday:   
Drawing 3:  Joining Materials

Color Explorations:  Phase III
Record computer questions on pieces of paper. 
Collect to answer later.
Small groups to show work and review problem constraints, goals and require-
ments.  Identify any questions. 
Hang compositions on the wall. 
Design discussion. 
Clear versus subtle hierarchy.  All areas need to be visible. 
How are pieces related. 
Visual cues and layering. 
Questions & Observations.
Due Wednesday: 
Preliminary design. 
Bring digital files and prints.

Break:  15 min.



28B E N E D I C T
Arch 122 Daily2008

A Folly:  Phase III
Give feedback on group designs. 
Hand out group grades.
Introduce Phase III 
Show past student work. 
Goals are to refine the model and document it for construction in Form-Z. 
To develop orthographic drawing understanding and skills. 
To use color to create orthographic design presentation drawings that indicate 
depth.
Work with your team to discuss design changes.
Work in class to develop Floor Plan.
Due Wednesday: 
Read Phase III 
Existing Floor Plan on cross section paper.  Everyone must draw.

Computer
Respond to questions on Freehand.
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1P Perspective
The drawing represents the shape of the 
space on the picture plane.
Construct with a straight edge.
Leave pencil construction lines.
5' Eye-Level Perspective
Room is 15' deep.
Label the GL, HL & VP.
Draw the Room.
Add a person.
Freehand trace all final lines in ink.
Shade selected surfaces to enhance 
depth.
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CLASS 13:  WEDNESDAY

Warm-up:  Review Strategies
Do a series of perspectives that review the basic strategies. 
Hand out print of base setup (see following page).   
Draw together.

Warm-up:  Perspective Quiz
One-point perspective exercise (see following page). 
Follow the instructions. 
I will collect the quiz in 15 min.
Collect Quiz
Review the basic construction process.

Break:  15 min.

Weekly Drawings:  Joining Materials
Small groups to present your goals and the drawing. 
Material representation, 3D form. 
Did anyone use a new technique?  What did you learn? 
Make observations.
Collect drawings.

Color Explorations:  Phase III
Groups of six or seven. 
Exchange preliminary compositions. 
Rank order from the most to the least successful. 
Identify two issues that help you rank them (e.g., contrast of color). 
Write the two issues on a sheet of paper so they can be read from ten feet. 
Hang your continua and issue sheets on the wall.
Bring your sketchbooks. 
Identify and record two patterns you see in qualities that contribute to success. 
Identify a design you think should move and note why?
Share observations and discuss issues.
Due Friday:   
Final Composition & preliminaries of 4 Contrasts 
Bring Prints and computer if you have questions.
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Folly:  Phase III
Introduce Phase III 
Show past student work. 
Goals are to refine the model and document it for construction in Form-Z. 
To develop orthographic drawing understanding and skills. 
To use color to create orthographic design presentation drawings that indicate 
depth.
Use initial floor plans & overlay with trash: 
Shade three major spaces.   
Shade Transition/Exterior spaces. 
Hang on the wall.  Comments.
Work with your teams to discuss and identify design improvements.
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HL

GL

VP

HL

GL

VP

HL

GL

VP

DVP

Drawing Form: Pages 31, 33, 49

Drawing Form: Pages 32, 35, 41

Drawing Form: Page 42
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1P Perspective
The drawing represents the shape of the 
space on the picture plane.
Construct with a straight edge.
Leave pencil construction lines.
5' Eye-Level Perspective
Room is 15' deep.
Label the GL, HL & VP.
Draw the Room.
Add a person.
Freehand trace all final lines in ink.
Shade selected surfaces to enhance 
depth.
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CLASS 14:  FRIDAY

Big Friday
Timed drawings from projected images. 
Media:  Art Stix &/or markers. 
Do three images. 
Time:  8 minutes each.

Break:  15 min.

Warm-up:  Perspective Quiz
One-point perspective exercise on the next page. 
Follow the instructions.  Think: 
What is the space the drawing is indicating? 
 Space with floor level change. 
What is first decision that you have to make? 
 What level is the viewer standing upon. 
I will collect the quiz in 20 min.
Collect Quiz

Weekly Drawings:  Reflection/Transparency
Introduce reflection/transparency drawing and show past work.
Refer to text book resources: 
Ching:  257-258 
Doyle:  10-11
Perspective of object and reflection are the same. 
Reflect around axis created by intersection of reflective plane and object or ex-
tension of object.
Lead the class through two sketches that look at reflections in vertical surfaces 
and introduce the basic concepts associated with the construction and rendering 
of reflections. 
Time:  30 min.
Due Monday: 
Read Doyle pages 5 - 21.
Due Wednesday: 
Drawing 4:  Reflection/Transparency

Break:  15 min.
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1P Section Perspective
Construct with a straight edge and leave 
pencil construction lines.
5' Eye-Level Perspective with person 
standing to the left at lower level.
Room is 20' deep.
Set and label the GL, HL & VP.
Put a 3' high by 8' wide window in the 
back wall.  It should be 4' above the 
lower level and 2' from the left wall.
Draw the Room.
Add a person at both levels.
Freehand trace all final lines  
in ink.
Shade selected surfaces to  
enhance depth.

2'-6"
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Color Explorations:  Phase III
Small groups to: 
Check if contrasts are done correctly 
Check if composition and contrast create different hierarchies of implied patterns 
and shapes. 
Identify any questions.
Hang drawings on the wall. 
Best transformation of composition. 
Groups identify clear versus ambiguous hierarchys.
Design discussion. 
Clear versus subtle hierarchy.  All areas need to be visible. 
How are pieces related. 
Visual cues and layering. 
Questions & Observations.
Due Monday: 
Phase III Final Submittal

Folly:  Phase III
Discuss process of establishing major requlating line and dimensions.  
Show examples. 
Gather with your team. 
Work on creating the regulating line and dimension drawing for your team.
Next Class:  Bring Cross Section paper and drawing tools.



38B E N E D I C T
Arch 122 Daily2008

CLASS 15:  MONDAY

Warm-up:  One-Point Perspective
Review the process for the last quiz. 
Hand out new copy of quiz. 
VP location and depth decisions. 
Half way between any line and VP for depth. 
Establishing depth with 1/3rd division and diagonal of a side. 
Locating window. 
People on upper level.
Make notes and paste into your sketchbook.

Weekly Drawings:  Reflection/Transparency
Perspective of object and reflection are the same. 
Reflect around axis created by intersection of reflective plane and object or ex-
tension of object.
Lead the class through a sketch of building reflecting in water. 
Technique for rendering water and reflections in water with wiggly horizontal 
lines. 
Time:  30 min..
Due Wednesday:   
Drawing 4:  Reflection/Transparency

Inspiring Architecture
Remind students about choosing an architect and purchasing a book.

Break:  15 min.

Color Explorations:  Phase III
Reflections: 
Two things you learned about color. 
One thing you learned about designing two-dimensional compositions.
Layout your five final sheets on your desk. 
Circulate to review. 
Hang your most beautiful version on the wall. 
Each person may add one from someone else they think should be on the wall.  
In your sketchbook do a thumbnail of one you think is most beautiful and three 
reasons why. 
Pin a card by the one you choose. 
What makes something beautiful? 
Discussion.
Collect grade sheet, prints and CD.
Copy of reflections due next class.
Alternate:
Small groups to present Design & Contrasts. 
You were to create a visual hierarchy of implied shapes and patterns. 
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Show your design to the group. 
Each member is to identify what their eye is drawn to first, second, third. 
Feedback:  Does the hierarchy match your intentions? 
Look at the contrasts.  Do they make the design look different. 
Time:  6 min.
Bring your sketchbook and hang large 2D designs on the wall. 
Reflections: 
Put you name on the page & Color Explorations. 
Choose one that makjes you go ooh.   
Draw a thumbnail and identify two qualities that cause your ooh. 
Identify three things you learned about making designs more visually interesting. 
Time:  5 min. 
Turn to a neighbor and share your observations. 
Time:  5 min. 
Estimate the number of hours spent on this project since Friday and note it on the 
reflections page.
Due Wednesday: 
Photocopy of reflection page from sketchbook.
Collect prints & digital files.

Break:  15 min.

Folly:  Phase III
Orthographic projection review of basic principles and processes. 
Orthogonal elements. 
Nonorthogonal elements with straight sides. 
Elements that are curved in plan. 
Nonorthogonal elements curved in elevation (Auxiliary Views). 
 Transfer dimensions with dividers.
Work in class with your team. 
Draw the Roof Plan and South Elevation of the simple space. 
Layout requirements provided and described in class. 
Drawings at 1/4" scale. 
Everyone does their own drawings. 
Work together to make sure everyone understands and the drawings match.
Process: 
Tape two 8.5 x 11" sheets of cross section paper together and work within the 
areas indicated on the handouts. 
The roof plan and elevation must be aligned and dimensions graphically related. 
Do auxilliary drawings as required. 
Draw additional details as required to solve connections.
Important:  You must resolve/design the joints between element.
If you finish the above continue to do the Floor Plan and an East/West section of 
the simple space.
This set of 4 drawings must be completed by the end of class on Wednesday. 
Will start the drawings of the middle space on Wednesday. 
Will start the drawings of the complex space on Friday.
Due Wednesday: 
Regulating lines and dimensions plan drawing on 11 x 17" velum. 
Ink all lines and use standard lettering for all dimensions and notes.
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CLASS 16:  WEDNESDAY

Warm-up:  One-Point Perspective
Perspective Quiz. 
Work on the sheet provided. 
Have final product on screen. 
Discuss issues as they are drawing. 
Half way between any line on the PP and the VP will equal depth. 
Arcs in perspective are true arcs that can be drawn with a compass. 
30 Minutes.
Collect Quiz

Weekly Drawings:  Transparency & Reflection
Small groups to present drawing. 
Identify two qualities that reflections and/or transparencies have that you tried to 
capture?
Hang drawings on the wall. 
Choose drawing with best sense of transparency and note why 
Choose drawing with best sense of reflection and note why. 
Identify two things that you learned about reflections and their representation. 
Share with your neighbor.  Share with class. 
Make any appropriate comments.
Collect drawings.

Break:  15 min.

Folly:  Phase III
Time to work on drawings in class.
Due Friday:   
As Is Floor Plan 
Scan of As Is Floor Plan 
Regulating Lines 
Simple Space Drawings 
Scan of South Elevation
Bring Computers
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CLASS 17:  FRIDAY

Big Friday
Get out your newspaper pad and Art Sticks. 
Project an image. 
Regulating lines. 
Draw.  Time:  8 min 
Hang on the wall & make observations. 
Repeat twice more.

Perspective
Return quiz. 
Make comments. 
Paste into your sketchbook.

Weekly Drawings
Return drawings and make comments.
Review requirements for next drawing.
Due Wednesday:  Drawing 5: Architecture

Break:  15 min.

Rendering:  Graphic Language
Draw a series of squares in your sketchbook using the sheet provided to trace.   
Line Quality. 
Line Weight & Front/Back 
Color Value and Richness, Front/Back 
Assumed Light Source
Shade in using 45°  
Use a mixture of colors. 
Create gradations to increase edge contrast.
Read in "Drawing" Pages 27-46
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Rendering:  Application Of Graphic Language
Depth & Perspective cues. 
Application to orthographic drawings.
Graphic Languages. 
Line Hierarchy:  Primary, Secondary, Tertiary line weight. 
Arial Perspective:  Size, Contrast, Chroma
Select a representative portion of your development drawings. 
Trace using appropriate line weights. 
Trace people and trees.  Entrouage section of "Drawing". 
Color using Arial Perspective. 
Do a Floor Plan, Roof Plan and Elevation sample.
Small groups to examine work. 
Suggestions for strengthening the sense of depth.
Hang finished sheets on the wall. 
Come close and inspect work. 
Make observations and ask for questions and comments.
Depth reinforced by value, hue and chroma? 
Depth reinforced by line weight? 
Drawing craft adds value?
Read in "Drawing" Pages 27-46

Folly:  Documentation Drawings
Collect drawings through Simple space.

Folly:  Presentation Drawings
Review requirements.
Due: Wednesday 
Render the South Elevation with people and trees.
Bring Computer
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CLASS 18:  WEDNESDAY

Warm-up:  One-Point Perspective
Return Perspective Quiz. 
Use 45° DVP to find dimensions.

Weekly Drawings
Small groups to review drawings. 
Show under camera and make comments.

Faculty Evaluations
Return results and ask for specific examples.
Due friday:  Wordprocessed responses.

Break:  15 min.

Color Explorations:  Phase III
Hang selected projects on the wall and present observations. 
Handout and explain the meaning of grade notes.

A Folly:  Phase III
Return Simple Space drawings and make comments.
Work in class to draw Intermediate Space.
Due Friday:   
Intermediate Space drawings.
Bring Computer.
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CLASS 19:  FRIDAY

Weekly Drawings:  Big Friday
Design Plates from Art.

Weekly Drawings
Return drawings and make comments.
Due Wednesday:  Final set.

Inspiring Architect
Due Monday: 
Look up book reference for an architect and print.

Break:  15 min.

A Folly
Work with group to develop orthographic drawings for Complex space.
Due Monday:   
Final set of Orthographic drawings.

Digital Folly
Introduce the problem and show past examples.
Due Monday: 
Read problem statement.
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Computer Tutorial:  Class 19-20

Define Surface Styles

Define Layers

Build the Site & Context

Define Buildable Plane

Uniformly Sloped Elements
Follow example in Form-Z maual.

30/60 Lights

Tree
Set grid snap to 6” to create the tree trunk.
Choose the 3D Extrusion modifier set to facetted.
Choose the circle drawing tool and set the # of Segments to 8.
Make a 1' diameter by 8' high cylinder centered on 0,0,0.  
Choose View > Front and zoom in to see tree construction area.
Use Vector Line tool with the 2D Surface modifier to draw the tree outline using 
the grid drawing from the project statement.  Note:  The grid must be set to 6" 
snap. 
Choose the Revolve tool set to Facetted and follow the Prompts palette instruc-
tions.  Set # of Steps to 24.
Render the tree.  Does it look right.  Use reverse direction tool if it does not. 
Set trunk and tree color. 
Use the Join tool to join the trunk and tree.

Self/Copy  (Page 50)
Move with:  One Copy, Continuous Copy, Repeat Copy, Multi Copy

Site Contours
Build and Union to site.

Pools
Dig a hole that defined the inside of the pool.  Make -4'-0" deep. 
Choose paint brush and paint inside of pool paving color. 
Note:  Maintain surface colors.
Make a water surface. 
Move the surface down -1'-0" or as appropriate.
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Creating Paving
Set height to 1 inch. 
Plan view to create areas of paving. 
If you are snaping to existing points set grid Snap to reference Plane. 
Add 1" high volume to define the top of the pool wall.
Make separate areas for each grid pattern. 
Apply surface mesh to each area.
Choose Query tool, Topological level to Object, Click on tool and change the At-
tributes to render as wireframe.

Arbitrary Planes (Page 83)
Arbitrary planes by points. 
Build points.  Snap to points. 
View > Plane Projection > Top

Moving (Page 49)
X,Y,Z Moving:  Change Active Grid.  Perpendicular Switch. 
Setup:  Move, One Copy, Point Snap 
Change the type of Object Snap in process.

Rotating (Page 53)
Rotate in orthographic views.
Rotate in 3D view with Point Snap on.

Boolean Operations (Page 57)
Boolean Union, Difference, Intersect, Split.

Extend (Page 68)
Extend Face:  To Face, From Face.

Attach (Page 69)
Choose Topological level:  Point, Segment, Face.
Select Attach tool:  Per Topological Level and Entire Object. 
Set other options. 
Click on object to be moved. 
Click on destination.
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CLASS 20:  MONDAY

Perspective
Hand out worksheet and Start exercise together. 
Complete in class.
Collect exercise.

Weekly Drawing
Due Wednesday:  Final Submittal

Folly:  Phase III
Lay your orthographic drawings out so that they can be checked during break.

Break:  15 min.

Folly:  Phase III
Work in Teams to define Site/Floor Plan drawing.
Due Wednesday: 
Documentation:  Final Submittal. 
Two Photocopies of each drawing.

Digital Folly
Work by yourself to build/define/save Surface Styles, Layers, Context. Site, 
Buildable Plane and 30/60 Lights. 
Provide help for each other with any technical questions. 
Check on installation problems.

Break:  15 min.

Computer Tutorial:  Class 19-20
30/60 Lights 
Tree 
Move and Copy 
Site Contours 
Pools 
Paving 
Arbitrary Planes by Points

Digital Folly
Time to work in class on building simple space.
Due Wednesday:  Simple Space completed 
Bring print.
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CLASS 21:  WEDNESDAY

Perspective:  One Point
Drawing with grids. 
Hand out object description. 
Hand out one point grid. 
Draw objects shown in plan in the grid. 
Line weight & shading to build depth. 
Time 40 min.
Collect drawings.

Weekly Drawing
Lay drawings out on tables & circulate. 
Reflections: 
Two new things you learned this quarter.
Collect drawings
Copy of Reflections due next class.

Break:  15 min.

Folly:  Phase III
Collect Documentation drawings.
Collect reflections.

Digital Folly
Hand out paper. 
Small groups to identify key model building problems.
Review tools.
Work Time
Respond to questions.
Individual help.
Due Friday: 
Print of 30/60 view of model. 
Print of simple space elevation and section.
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20' Tall

8' Tall

8' Tall

12' Tall

Each 
Grid is 
4' x 4'

Eye height @ 6'
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CLASS 22:  FRIDAY

Big Friday
Designing Masks from art.

Break:  15 min.

Perspective:  70/20 Perspective Chart
Hand out 20/70 grids. 
Draw objects shown in plan in the grid. 
Line weight & shading to build depth. 
Time 20 min.

Break:  15 min.

Digital Folly
Small groups to present prints. 
Hand out paper for questions.
Collect First Submittal:  Roof Plan, Floor Plan, Sections and Elevations.
Due Monday: 
Final Submittal:  Prints, Digital File and Grade Sheet. 
Second set of prints for you to work with.

Computer Tutorial:  Class 21
Respond to questions.
Printing problems.
Defining perspectives. 
Lighting perspectives.
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CLASS 23:  MONDAY

Perspective:  30/60 Perspective Chart
Hand out 60/30 grids. 
Draw objects shown in plan in the grid. 
Line weight & shading to build depth. 
Time 20 min.

Break:  15 min.

Weekly Drawings
Questions
Due Wednesday: 
Final set of five drawings with backing sheets.

Sequential Experience:  Phase I
Review goals of the final project.
Questions form reading the problem statement?
Will be worked during class on Monday.   
You need a set of perspectives: Refer to What You See in The Experience.
Due Monday:  Perspectives in Hidden Line mode on Typing paper.

Digital Folly
Small groups to present perspectives. 
Lighting that differentiates surfaces.
Hang your best perspective on the wall. 
In your sketchbook record four things that you learned from this project. 
How much time spect since Friday.
Observe best lighting.
Collect Project submittal.

Break:  15 min.

Sequential Experience:  Analysis
Analysis:  What You See
Overlay the perspectives and make note in response to the questions under What 
Your See.  Transfer the notes neatly to the set of Hidden Line prints.
Small groups to present observations. 
Can you see what the person is describing in the perspectives? 
Gather.  Questions?
Due Wednesday: 
Completed What You See sheets. 
New set of Hidden Line perspective prints to draw over.
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CLASS 24:  WEDNESDAY

Perspective:  Shadow Casting
Flag Poles and Goal posts. 
Casting Edge, Sun Bearing and Sun Ray.

Weekly Drawing
Layout your drawings on your table.  Circulate and enjoy the quarter’s work.
Reflections 
Two things that improved in your drawing this quarter. 
Two new things you learned this quarter.
Everyone share one of their reflections.  Reinforce key ideas they bring up.
Collect Drawings 
Photocopy of reflections on break.

Break:  15 min.

The Experience:  Phase I 
What You See 
Gather is small groups. 
Each person is to present what they see in their three views that work or does not 
work in terms of the continuum. 
Make comments.
Ideas For Change 
Introduce next step. 
Work over Hidden line drawings to propose continuum improvements. 
Hang drawings on the wall.

Break:  15 min.

The Experience:  Phase I
Practice Rendering 
Discuss the rendering approach that will be used. 
Do an hand rendering example using handouts.
Due Friday: 
Phase I Final submittal. 
Prints of one space in both Hidden Line and Renderzone.
Readings:  Color Drawing
Page 239 & 246:  Color, Value, Light, Simple. 
Page 241 & 248:  Dark foreground, Light subject. 
Pages 260 - 262:  Value Strategy 
Pages 52 - 54:  Creating the effects of Light. 
Pages 60 -64:  Toned backgrounds.
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CLASS 25:  FRIDAY

Big Friday
Designing Chairs from art.
Reflection on Big Friday Drawings. 
What value have they been for you. 
Suggestions for changes.
Organize Quarters Drawings.

Break:  15 min.

Perspective:  Shadow Casting
Shadow casting further developed. 
Shadow from volume. 
Shadow up wall.

Experiential:  Phase I, Analysis
Small groups to present Ideas For Changes. 
What you have done to improve the experience of the continuum. 
Suggestions for improving continuum.
Collect Phase I

Break:  15 min.

Computer Tutorial
Exporting views from form-Z.
Assembling views in Photoshop.
Bringing in and scaling entourage.

Experiential:  Presentation
Practice rendering. 
Make suggestions for use of media. 
Everyone is to render the view they brought to class.
Due Monday: 
Value & Line prints of your Three Views. 
One view rendered.
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CLASS 26:  MONDAY

Perspective:  Shadow Casting
Shadow casting further developed. 
Shadow over ditch. 
Shadow up slope.

Digital Folly
Return Project and grades. 
Make comments.

Experience:  Analysis
Return Phase I and grades. 
Make comments.
Generally you are not drawing observations and conclusions from the diagrams 
and views.  You are explaining why you created the diagram as you did and and 
describing what is.

Break:  15 min.

Experience:  Rendering
Small groups to show renderings. 
Offer suggestions for improving the renderings based on the project goals. 
Learn new techniques form each other.
Hang renderings on the wall. 
Comments and Observations.
Make suggestions under the camera for trees and planting.

Break:  15 min.

Experience:  Presentation
Hang past presentation examples on the wall. 
Students critique alternatives in their sketchbooks. 
Students share observations.
Make comments.
Review Freehand setup and printing.
Due Wednesday 
One completed Rendering. 
Scan of rendering at 300 dpi. 
Presentation preliminary- full size prints. 
Bring digital files (Freehand and Photoshop.

Work & Question Time
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CLASS 27:  WEDNESDAY

Class Starts @ 9:00 AM

Experience:  Presentation
Hang all work on the wall. 
Comments and observations.

Experience:  Rendering
Small groups to present final renderings.
Hang all work on the wall. 
Comments and observations.
Review what is due on Friday. 
Ask if there are any questions?
Due Friday: 
Final Print. 
Original drawings 
All digital files.

Teacher Evaluation
Hand out and have student collect and turn in.

Break:  15 min.

Architect
Confirm choice of architect.
Due the first day of class next quarter. 
Book on your architect.

Exit Interviews
Sign-up sheets.

Computer Tutorial:  Class 27 
Finishing renderings in Photoshop.
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CLASS 28:  FRIDAY

Class Starts @ 9:00 AM

Exit Interviews
Sign-up sheets.

Sequential Experience:  Presentation
Small groups to show presentations. 
Being in the spaces, sense of space.
Hang drawings on the wall. 
Reflections:  In your sketchbook note five things that you learned from this proj-
ect.

Sketchbook & Resubmittals
All due by 5:00 pm on Monday.
Resubmittals must include original submittal.
Bring to the classroom.

Closing Comments
Gather in a circle.


